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适用于低于 1GHz 网络的能量收集环境光和环境传感器节点

TI 参考设计

设计 特性

此 TI 参考设计演示了一种功耗超低的可再生无线环境感
应方法，这种方法利用了日光能量收集技术，具有极长
的备用电池寿命。此设计使用了德州仪器 (TI) 的超低功
耗收集装置电源管理、低于 1GHz 的 SimpleLink™ 超
低功耗无线微控制器 (MCU) 平台以及环境光线、湿度
和温度传感技术，可在能量收集电路启用时进行连续监
控，在依赖备用电池供电运行时中断监控。

•

在照度水平足够高时完全依赖太阳能运行（连续模
式）

•

在照度水平不能满足要求时，备用电池将向电路供
应能量

•

感应投射到建筑物内的自然环境光线以便精确控制
建筑物的照明系统

•

除了环境光线外，还监控温度和相对湿度

设计资源

特色 应用

TIDA-00488
bq25505
CC1310
OPT3001
HDC1000
CSD75208W1015
TPD1E10B06
TIDA-00758

设计文件夹
产品文件夹
产品文件夹
产品文件夹
产品文件夹
产品文件夹
产品文件夹
工具文件夹

•

智能照明

•

日光收集装置

•

环境传感节点

•

无线传感器节点

•

物联网 (IoT)

•

HVAC 传感器

•

楼宇自动化

请咨询我们的 E2E 专家
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Key System Specifications
表 1. Key System Specifications
PARAMETER

SPECIFICATION

DETAILS

Solar cell

IXYS IXOLAR SolarBIT (amorphous) works in indoor and outdoor locations

2.7 节

Non-rechargable
battery

CR2032 Lithium-ion coin cell battery (3.0-V nominal voltage)

2.6 节

VBAT_OV

Maximum voltage capacitor reservoir

3.50 V

4.2 节

VBAT_OK_HYST

Level at which capacitor reservoir is charging and becomes connected
to load as the main power source

2.51 V

4.2 节

VBAT_OK

Level at which capacitor reservoir is discharging and becomes
disconnected from load

1.90 V

4.2 节

Capacitor reservoir
size

1200 µF (ceramic)

4.1 节

1000 lux
Capacitor reservoir
charge-up time

700 s

2000 lux

Load connect at 2.51 V from disconnect at 1.90 V

4000 lux

2

250 s

6.2 节

125 s

Power
management
control

When the capacitor reservoir is charging and reaches 2.5 V, the reservoir connects to
the load. Once 3.5 V is reached, the reservoir disconnects from the input power source
until discharged to less than 3.5 V. If the reservoir discharges to 1.9 V, the reservoir
disconnects from the load.

Sensor type

Ambient light, humidity, temperature

Measurement
interval

Once every 15 seconds

Average off-state
current
consumption

1 µA

节 6.3.1

On-state duration

20 ms

节 6.3.2

Off-state duration

14.98 s

节 6.3.2

Working
environment

–30°C to 60°C

Form factor

2.0×3.0-in rectangular PCB

2.4 节
2.1 节; 2.2 节
6.1 节

2.7 节
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System Description
Many industrial, building automation, and IoT systems require increasing numbers of wireless sensor
nodes. Power distribution and consumption are two of the major constraints of adding many wireless
sensor end-nodes to a system. Typical sensor end-nodes are powered by batteries, which last from
several months to several years depending on the power consumption of the end node. Replacing
batteries can increase the system-level cost significantly, so it is important to ensure the sensor node uses
very little power to guarantee long battery life.
Additionally, many building automation systems are beginning to require ambient light sensors to monitor
the effect of varying levels of natural light in the building.

图 1. Light Sensing for Building Automation
By smartly monitoring the ambient light level, the effects of the sun coming out from behind clouds, or
conversely, the natural light level decreasing due to clouds or nighttime, can be mitigated. Light control
could happen through a number of methods, including automatic blind operation and artificial light level
adjustments.
A major tradeoff exists between battery life and frequency of data collection for sensor nodes. If very
frequent (1 to 10 seconds) data collection and transmission is required, then batteries must either have a
very large capacity or be changed very frequently.
Enabled by Texas Instruments’ ultra-low power harvester power management, SimpleLink ultra-low power
wireless MCU platform, ambient light sensing, and humidity sensing technologies, the Energy Harvesting
Ambient Light and Environment Sensor Node for Sub-1GHz Networks TI Design demonstrates an ambient
light sensor node with a continual transmission mode using daylight harvesting to achieve extremely long
system life with Sub-1GHz wireless communication.
This design guide addresses component selection, design theory, and the testing results of this TI Design.
The scope of this design guide gives system designers a head-start in integrating TI’s ultra-low power
harvester power management, SimpleLink ultra-low power wireless MCU platform, ambient light sensing,
and humidity sensing technologies.
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Continual Transmission Mode Using Daylight Harvesting
To achieve a premium level of ambient light and environmental sensor data, it is necessary to transmit
data to a central building control at a relatively high frequency (every 1 to 20 seconds). However, such
high rates of sensor measurement and wireless communication results in poor system battery life. To
overcome this constraint, daylight harvesting provides system power to supplement a battery for scenarios
where a premium level of sensor data is required.
Daylight harvesting consists of using solar cells to power the sensor node. The solar cell collects energy
from the ambient light in the installation location and feeds it to an energy harvesting power management
device. The power management device buffers that solar energy into a large capacitor reservoir, and once
the charge in that bank has accumulated sufficiently, the system will be powered from the reservoir.
Alternatively, if sufficient charge has not been collected, a CR2032 coin cell battery provides system
power. The power management device gives an indication of the actively used power source (solar cells
or coin cell battery) to the wireless MCU. With this information, the wireless MCU makes measurements
and wirelessly transmits less often when running from the coin cell battery to prevent its premature
depletion.

2.2

Ambient Light Sensor
In this TI Design, an ambient light sensor provides an extremely accurate ambient light measurement that
very closely matches the spectrum of the human eye. Knowing an accurate ambient light level enables
smart buildings to accurately and intelligently control the environmental conditions to increase occupants’
comfort and energy performance of the building.
The OPT3001 from Texas Instruments has flexible operating modes. This TI Design uses a low-power
one-shot measurement mode and a data ready interrupt feature because the measurement rate is welldefined.
The OPT3001 is ideally suited for sensing lighting due to its ambient light linearity of 2% and rejection rate
of infrared (IR) light greater than 99%. Furthermore, the OPT3001 has extremely low power consumption
with an average current of 1.8 μA and an average shutdown current of 0.3 μA. Connecting the wireless
MCU to this device is straightforward using an I2C interface.

2.3

Humidity and Temperature Sensor
In this TI Design, a humidity and temperature sensor was incorporated to demonstrate multiple sensing
options. Similar to ambient light sensing, humidity and temperature are common measurement parameters
in industrial and building automation applications.
With a relative humidity accuracy of ±3% and a temperature accuracy of ±0.2°C, the HDC1000 can
accurately sense humidity and temperature data. The HDC1000 is a very low power device, averaging 1.2
μA at a one sample per second measurement rate when active and 200 nA or less when in sleep mode.
Connecting the wireless MCU to this device is straightforward using an I2C interface.

2.4

Ultra-Low Power Wireless MCU
In this TI Design, transmitting the sensor information to a central location for processing is necessary.
However, because power consumption is always a concern in battery-powered applications, the radio and
processor must be low power. Also, the wireless protocol required for the end-equipment system is an
important consideration for the selection of the radio device.
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The TI CC1310 SimpleLink ultra-low power wireless MCU platform is a low-power device with a combined
radio and MCU. The CC1310 enables extremely long battery life for sensor end-nodes. Furthermore, the
CC1310 is a multi-standard device with software stack support for wM-Bus and TI’s SimpliciTI™ star
network protocol. In this TI Design, a generic proprietary protocol was implemented, but the hardware can
work with other protocols as well.
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Daylight Harvester Power Management
As described previously, for applications that require a premium level of sensor data, daylight harvesting is
a solution that eliminates frequent battery changes while still maintaining frequent data measurement and
wireless transmission. However, to effectively use daylight energy, an intelligent energy harvester power
management device is required because solar cells typically have high-output impedance and low-output
voltage, which cannot directly power the rest of the sensor node devices.
In this TI Design, the bq25505 regulates the energy provided by the solar cells. The bq25505 is
specifically designed to efficiently extract the microwatts (μW) to milliwatts (mW) of power generated from
high-impedance solar cells without collapsing the cells. The harvested power is stored in a 1200-μF
ceramic capacitor reservoir. The bq25505 also manages a CR2032 coin cell backup battery, which is used
when there is not sufficient ambient light to power the sensor node.
Furthermore, the bq25505 implements several user friendly features. Users can program the voltage
levels of the capacitor reservoir that allow the bq25505 to properly connect and disconnect the two power
sources to the load. Users can also program the maximum power point tracking (MPPT) sampling network
to optimize input power provided by the solar cell.

2.6

Low On-Resistance Load Switch
This TI Design uses a low on-resistance load switch to implement a power multiplexer that connects the
wireless MCU and sensing devices to either the backup battery or capacitor reservoir. The most important
characteristic of this switch is the low on-resistance. The load is always connected to either the capacitor
reservoir or the backup battery through one of these load switches. Therefore, the on-resistance is a
critical parameter of the load switches to prevent excess power loss that reduces the system’s life.
In this design, the CSD75208W1015 was chosen as the load switch to connect the sensor nodes and
MCU to the appropriate power source. Key features of this switch are the dual P-Channel MOSFETs and
the 120-mΩ drain-to-drain resistance.

2.7

Coin Cell Battery
For this TI Design, a CR2032 lithium-ion coin cell battery was chosen as a back-up battery for the
continual sensing operation. This battery type was chosen due to do its ubiquity and small size.
The voltage characteristics for the CR2032 lithium coin cell are ideal as well. The output voltage of the
battery is relatively constant until the battery is nearly depleted. At this stage, the voltage begins to
decrease exponentially until the battery is depleted in full.
The temperature characteristics of lithium-ion batteries are superior to that of alkaline cells. However, the
operating temperature range of the CR2032 is more limiting than the other components used in this
design. Therefore, the temperature range of this TI Design is –30°C to 60°C.
Following the battery is a Schottky diode. This diode prevents damage to the other components used in
this design in the case that the battery is inserted backwards. A bulk capacitor is placed in parallel with the
battery to provide an energy buffer, which will prevent the battery voltage from sagging during significant
current draw events. In this TI Design, the wireless MCU transmission is the source of such current draws.
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2.8

Solar Cell
The IXYS IXOLAR™ High Efficiency SolarBIT solar cells (part number: KXOB22-12X1L) were chosen as
the primary solar power source for this TI Design. The KXOB22-12X1L solar cell is monocrystalline and
was chosen due to its small size of 0.7 × 2.2 cm per cell, 0.63-V open circuit voltage rating, and high 50.0mA short circuit current rating.
This solar cell can operate over a wide range of electromagnetic wavelengths. Therefore, the TI Design
can be used in both indoor and outdoor settings, assuming that a sufficient light level is present. The
primary intended use-case for this TI Design is for indoor commercial environments.
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Block Diagram
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图 2. Energy Harvesting Ambient Light and Environment Sensor Node for Sub-1GHz Networks System
Block Diagram

3.1

Highlighted Products
The reference design features the following devices:
•

bq25505: Ultra-low power harvester power management ic with boost charger, and autonomous power
multiplexor (节 3.1.1)

•

CC1310: SimpleLink sub-1GHz ultra-low power wireless MCU (节 3.1.2)

•

OPT3001: Digital ambient light sensor (ALS) with high precision human eye response (节 3.1.3)

•

HDC1000: Low-power, 3% accuracy digital humidity sensor with integrated temperature sensor (节
3.1.4)

•

CSD75208W1015: Dual common-source 20-V P-Channel NexFET™ power MOSFETs (节 3.1.5)

•

TPD1E10B06: Single-channel ESD in 0402 package with 10-pF capacitance and 6-V breakdown (节
3.1.6)

For more information on each of these devices, see their respective product folders at www.ti.com.
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3.1.1

bq25505
The bq25505 device is specifically designed to efficiently extract the microwatts (µW) to miliwatts (mW) of
power generated from a variety of DC energy harvesting, high-impedance sources like photovoltaic (solar)
or thermal electric generators (TEGs) without collapsing those sources. The battery-management features
of the bq25505 ensure that a secondary rechargeable battery is not overcharged by this extracted power,
with voltage boosted, nor depleted beyond safe limits by a system load. The integrated multiplexer gate
drivers autonomously switch the system load to a primary nonrechargeable battery if the secondary
battery voltage falls below the user-defined VBAT_OK threshold.
VSTOR

LBST

VBAT_SEC

VBAT_PRI
PFM Boost
Charger
Controller

VOR
CKT

VSS

VSS
Cold-start
Unit

VB_PRI_ON

Enable
Enable

VB_SEC_ON
VIN_DC

Interrupt

VBAT_OK
VOC_SAMP

OK_PROG
BAT_SAVE
+

VREF_SAMP

Battery Threshold
Control

OT

VREF

+

MPPT
Controller

OK

OK_HYST

UV

OV

Temp
Sensing
Element

+

+

VREF

Bias Reference &
Oscillator
VREF
VBAT_UV

EN

VBAT_OV

VRDIV

图 3. bq25505 Functional Block Diagram
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Features:
•

Ultra-low power with high-efficiency DC-DC boost charger
– Cold-start voltage: VIN ≥ 330 mV
– Continuous Energy harvesting from input sources as low as 100 mV
– Ultra-low quiescent current of 325 nA
– Input voltage regulation prevents collapsing high-impedance input sources
– Ship mode with < 5 nA from battery

•

Energy storage
– Energy can be stored to rechargeable li-ion batteries, thin-film batteries, super-capacitors, or
conventional capacitors

•

Battery charging and protection
– Internally set undervoltage level
– User-programmable overvoltage level

•

Battery-good output flag
– Programmable threshold and hysteresis
– Warn attached MCUs of pending loss of power
– Can be used to enable or disable system loads

•

Programmable MPPT
– Integrated MPPT for optimal energy extraction from a variety of energy harvesters

•

Gate drivers for primary (nonrechargeable) and secondary (rechargeable) storage element multiplexing
– Autonomous switching based on VBAT_OK
– Break-before-make prevents system rail droop
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3.1.2

CC1310
The CC1310 is the first part in a Sub-1GHz family of cost-effective, ultra-low power wireless MCUs. The
CC1310 combines a flexible, very-low power RF transceiver with a powerful 48-MHz Cortex®-M3 MCU in
a platform supporting multiple physical layers and RF standards. A dedicated Cortex-M0 MCU is handling
low-level RF protocol commands that are stored in ROM or RAM, thus ensuring ultra-low power and
flexibility. The low-power consumption of the CC1310 does not come at the expense of RF performance;
the CC1310 has excellent sensitivity and robustness (selectivity and blocking) performance. The CC1310
is a highly integrated solution offering a complete RF system solution, which includes an on-chip DC-DC
converter into a true single-chip solution down to a 4×4-mm package.
Sensors can be handled in a very low power manner by a dedicated autonomous ultra-low power MCU
that can be configured to handle analog and digital sensors; thus, the main MCU (Cortex-M3) sleeps for
as long as possible. Software stack support for this device is as follows:
•

wM-Bus

•

SimpliciTI (star network)

图 4. CC1310 Functional Block Diagram
Features:
•

MCU:
– Powerful ARM® Cortex-M3
– EEMBC CoreMark score: 142
– Up to 48-MHz clock speed
– 128KB of in-system programmable flash
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– 8KB SRAM for cache
– Up to 20-KB of ultra-low leakage SRAM
– 2-Pin cJTAG and JTAG debugging
– Supports over-the-air (OTA) upgrade
•

Ultra-low power sensor controller:
– 16-bit architecture
– 2KB of ultra-low leakage SRAM for code and data

•

Efficient code size architecture, placing peripheral drivers, RTOS, RF drivers, and bootloader in ROM

•

RoHS-compliant packages:
– 4×4-mm RSM QFN32 (10 GPIOs)
– 5×5-mm RHB QFN32 (15 GPIOs)
– 7×7-mm RGZ QFN48 (30 GPIOs)

•

Peripherals:
– All digital peripheral pins can be routed to any GPIO
– 4 general-purpose timer modules (8×16-bit or 4×32-bit timer, PWM each)
– 12-bit ADC, 200-ksps, 8-channel analog MUX
– Continuous comparator
– Ultra-low power analog comparator
– Programmable current source
– UART
– 2 × SSI (SPI, µW, TI)
– I2C
– I2S
– Real-time clock (RTC)
– AES-128 security module
– True random number generator (TRNG)
– Support for eight capacitive sensing buttons
– Integrated temperature sensor

•

External system:
– World’s smallest sub-1 GHz wireless MCU: 4 × 4 mm
– On-chip internal DC-DC converter
– Very few external components
– Seamless integration with the SimpleLink CC1190 range extender
– Pin compatible with the SimpleLink CC26xx

•

Low power:
– Wide supply voltage range:

12

•

Normal operation: 1.8 to 3.8 V

•

External regulator mode: 1.65 to 1.95 V
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– Active-mode RX: 5.5 mA
– Active-mode TX at 10 dBm: 12 mA; 14 dBm: 25 mA
– Active-mode MCU: 61 µA/MHz
– Active-mode MCU: 48.5 CoreMark/mA
– Active-mode sensor controller: 8.2 µA/MHz
– Standby: 0.7 µA (RTC running and RAM/CPU retention)
– Shutdown: 100 nA (wakeup on external events)
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RF section:
– Excellent receiver sensitivity:
•

–121 dBm at 2.4 kbps

•

–111 dBm at 50 kbps

– Very good selectivity and blocking performance
– Data rate up to 4 Mbps
– Modulation support: MSK, FSK, GFSK, OOK, ASK, 4GFSK, CPM (shaped-8 FSK)
– Highly flexible RF modem (software-defined radio) to also cover legacy and proprietary
communication protocols
– Programmable output power up to 15 dBm with shared RX and TX RF pins (regulated power
supply)
– Antenna diversity
– Coding gain
– Suitable for systems targeting compliance with worldwide radio frequency regulations:

•

•

ETSI EN 300 220, EN 303 131, EN 303 204 (Europe)

•

FCC CFR47 Part 15 (US)

•

ARIB STD-T108 (Japan)

Tools and development environment:
– Full-feature and low-cost development kits
– Multiple reference designs for different RF configurations
– Packet sniffer PC software
– Sensor controller studio
– SmartRF™ Studio
– SmartRF Flash Programmer 2
– IAR Embedded Workbench® for ARM
– Code Composer Studio™
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3.1.3

OPT3001
The OPT3001 is a sensor that measures the intensity of visible light. The spectral response of the sensor
tightly matches the photopic response of the human eye and includes significant infrared rejection.
The OPT3001 is a single-chip lux meter, measuring the intensity of light as visible by the human eye. The
precision spectral response and strong IR rejection of the device enables the OPT3001 to accurately
meter the intensity of light as seen by the human eye regardless of light source. The strong IR rejection
also aids in maintaining high accuracy when industrial design calls for mounting the sensor under dark
glass for aesthetics. The OPT3001 is designed for systems that create light-based experiences for
humans, and an ideal preferred replacement for photodiodes, photoresistors, or other ambient light
sensors with less human eye matching and IR rejection.
Measurements can be made from 0.01 lux up to 83k lux without manually selecting full-scale ranges by
using the built-in, full-scale setting feature. This capability allows light measurement over a 23-bit effective
dynamic range.
The digital operation is flexible for system integration. Measurements can be either continuous or singleshot. The control and interrupt system features autonomous operation, allowing the processor to sleep
while the sensor searches for appropriate wake-up events to report through the interrupt pin. The digital
output is reported over an I2C- and SMBus-compatible, two-wire serial interface.
The low power consumption and low power supply voltage capability of the OPT3001 enhance the battery
life of battery-powered systems.
VDD

1
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Human Eye

0.9

VDD

Normalized Response

0.8
OPT3001
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Ambient
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800

900

1000
D001

图 5. Spectral Response of OPT3001 and Human Eye

图 6. OPT3001 Functional Block Diagram

Features:
•

Precision optical filtering to match human eye:
– Rejects > 99% (typ) of IR

•

Automatic full-scale setting feature simplifies software and ensures proper configuration

•

Measurements: 0.01 lux to 83k lux

•

23-bit effective dynamic range with automatic gain ranging

•

12 binary-weighted full-scale range settings: < 0.2% (typ) matching between ranges

•

Low operating current: 1.8 µA (typ)

•

Operating temperature range: –40°C to 85°C
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•

Wide power-supply range: 1.6 to 3.6 V

•

5.5-V tolerant I/O

•

Flexible interrupt system

•

Small-form factor: 2.0 × 2.0 × 0.65 mm
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3.1.4

HDC1000
The HDC1000 is a digital humidity sensor with integrated temperature sensor that provides excellent
measurement accuracy at very low power. The device measures humidity based on a novel capacitive
sensor. The humidity and temperature sensors are factory calibrated. The innovative Wafer Level Chip
Scale Package (WLCSP) simplifies board design with the use of an ultra-compact package. The sensing
element of the HDC1000 is placed on the bottom part of the device, which makes the HDC1000 more
robust against dirt, dust, and other environmental contaminants. The HDC1000 is functional within the full
–40°C to 125°C temperature range.
RH

HDC1000

VDD

Registers
+
Logic

ADC

I2C

SDA
SCL
DRDYn
ADR0
ADR1

OTP
Calibration Coefficients

TEMPERATURE

GND

图 7. HDC1000 Functional Block Diagram
Features:
•

Relative humidity (RH) operating range: 0% to 100%

•

14-bit measurement resolution

•

Relative humidity accuracy: ±3%

•

Temperature accuracy: ±0.2 °C

•

200-nA sleep mode current

•

Average supply current:
– 820 nA at 1sps, 11-bit RH measurement
– 1.2 µA at 1sps, 11-bit RH and temperature measurement

•

Supply voltage: 3 to 5 V

•

Tiny 2×1.6-mm device footprint

•

I2C interface
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CSD75208W1015
This device is designed to deliver the lowest on-resistance and gate charge in the smallest outline
possible with excellent thermal characteristics in an ultra-low profile. Low on-resistance coupled with the
small footprint and low profile make the device ideal for battery operated space constrained applications.

P0099-01

图 8. CSD75208W1015 Device Configuration
Features:

18

•

Dual P-channel MOSFETs

•

Common source configuration

•

Small footprint: 1 × 1.5 mm

•

Gate-source voltage clamp

•

Gate ESD protection: –3 kV

•

Pb free

•

RoHS compliant

•

Halogen free

适用于低于 1GHz 网络的能量收集环境光和环境传感器节点

ZHCU182B – December 2015 – Revised May 2016

TIDUB22 — http://www-s.ti.com/sc/techlit/TIDUB22
版权 © 2015–2016, Texas Instruments Incorporated

Block Diagram

www.ti.com.cn

3.1.6

TPD1E10B06
The TPD1E10B06 device is a single-channel electrostatic discharge (ESD) transient voltage suppression
(TVS) diode in a small 0402 package. This TVS protection product offers ±30-kV contact ESD, ±30-kV
IEC air-gap protection, and has an ESD clamp circuit with a back-to-back TVS diode for bipolar or
bidirectional signal support. The 12-pF line capacitance of this ESD protection diode is suitable for a wide
range of applications supporting data rates up to 400 Mbps. The 0402 package is an industry standard
and is convenient for component placement in space-saving applications.
Typical applications of this ESD protection product are circuit protection for audio lines (microphone,
earphone, and speaker phone), SD interfacing, keypad or other buttons, VBUS pin and ID pin of USB
ports, and general-purpose I/O ports. This ESD clamp is good for the protection of the end equipment like
ebooks, tablets, remote controllers, wearables, set-top boxes, and electronic point of sale equipment.

1

2

图 9. TPD1E10B06 Functional Block Diagram
Features:
•

Provides system-level ESD protection for low-voltage IO interface

•

IEC 61000-4-2 level 4

•

±30-kV (air-gap discharge)

•

±30-kV (contact discharge)

•

IEC 61000-4-5 (surge): 6 A (8/20 μs)

•

IO capacitance: 12 pF (typical)

•

RDYN: 0.4 Ω (typical)

•

DC breakdown voltage: ±6 V (minimum)

•

Ultra-low leakage current: 100 nA (maximum)

•

10-V clamping voltage (maximum at IPP = 1 A)

•

Industrial temperature range: –40°C to 125°C

•

Space-saving 0402 footprint (1.0 × 0.6 × 0.5 mm)
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System Design Theory
The Energy Harvesting Ambient Light and Environment Sensor Node for Sub-1GHz Networks TI Design
measures ambient light, relative humidity, and temperature, while achieving an extremely long battery life.
The following sections describe in more detail the theory used to properly design this sensor node.

4.1

Continual Transmission Mode Using Daylight Harvesting Design Theory
For applications that require a premium level of sensor data, meaning that wireless transmissions of data
occur every few seconds, the continual transmission mode of this TI Design is required. In this instance,
as described previously, it is necessary to provide power using solar cells and the bq25505. Otherwise,
batteries would have to be constantly changed.
The following subsections describe the design aspects necessary to ensure proper operation of the
continual transmission mode.

4.1.1

Capacitor Reservoir Selection
The main parameters that affect the amount of energy needed to continuously collect and transmit
environment data are:
•

Current consumed by sensor nodes and MCU (mA)

•

Desired maximum change in voltage of capacitor reservoir during energy required event (V)

•

Amount of time during an energy required event (ms)

公式 1 describes the amount of capacitance needed to supply energy to the MCU and the sensor nodes
for this TI Design:
I ON ´ DT ON
C>
DV CAP
(1)
When choosing the maximum change in voltage, consider the desired setting of the overvoltage threshold
on the bq25505 and the programmed VBAT_OK setting. This change in voltage should be less than the
difference between these two values.
When performing this calculation, focus on the values of the highest energy occurring events. For this TI
Design, the initial powering of the CC1310 and sensor nodes and the transmission of a signal by the
CC1310 were examined. During each of these events, a large amount of current is drawn.
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4.1.2

Capacitor Reservoir Operating Range
For the continual transmission mode, the power management of the bq25505 must be configured
appropriately. This includes setting an appropriate voltage range condition where the load is receiving
energy from the capacitor reservoir (VBAT_SEC) instead of from the backup battery (VBAT_PRI).
VBAT_OK_PROG indicates when the capacitor reservoir has discharged to an unacceptable amount.
When this occurs, the load will start receiving energy from the backup battery and enable the capacitor
reservoir to recharge. VBAT_OK_PROG can be set with an external voltage divider based on 公式 2:

æ
R OK2 ö
VBAT _ OK _ PROG = VBIAS ç 1 +
÷
ç
R OK1 ÷ø
è

(2)

When the capacitor reservoir is charging, the threshold to switch the energy supplied to the sensor nodes
and MCU from the battery to the capacitor reservoir can be set with an external voltage divider based on
公式 3:
æ
R OK2 + R OK3
VBAT _ OK _ HYST = VBIAS ç 1 +
ç
R OK1
è

ö
÷
÷
ø

(3)

The sum of the resistors is recommended to be no higher than approximately:
R OK1 + R OK2 + R OK3 = 13 MW

(4)

The logic high level of this signal is equal to the VSTOR voltage and the logic low level is ground. The
logic high level has ~20 kΩ internally in series to limit the available current to prevent MCU damage until it
is fully powered. The VBAT_OK_PROG threshold must be greater than or equal to the UV threshold.
If the capacitor reservoir is supplying energy to the load while it is charging and reaches its overvoltage
value, the bq25505’s internal power management stops charging the capacitor reservoir, allowing it to
slightly discharge and preventing it from damaging the sensor nodes and MCU. This overvoltage threshold
can be set by an external resistor divider based on 公式 5:
VBAT _ OV =

æ
R OV2 ö
3
VBIAS ç 1 +
÷
ç
2
R OV1 ÷ø
è

(5)

The sum of the resistors is recommended to be no higher than 13 MΩ (that is, ROV1 + ROV2 = 13 MΩ).
4.1.3

Maximum Output Power Point Tracking (MPPT)
High impedance DC sources have a maximum output power point (MPP) that varies with ambient
conditions. For this TI Design, MPPT must be used to receive the maximum amount of input power from
the solar panel. A solar panel’s MPP varies with the amount of light shined on the panel as well as the
temperature. The datasheet of the selected solar panel should list the typical MPP open circuit voltage
and short circuit current, both of which are a percentage of their original amount. An external voltage
divider can be set by 公式 6:
R OC2 + 10 MW
V OC _ MPP
=
R OC1 + R OC2 + 10 MW
V OC
(6)
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Firmware Control
The firmware for the TIDA-00488 is designed for continual transmission, where data packets will be
transmitted at set intervals.
START

Initialization task, radio,
OPT3001, and HDC1000

Solar cell

Power source?

Set counter for 15 seconds

Coin cell battery

Set counter for 1 minute

OPT3001 start conversion

HDC1000 start conversion

HDC I2C
access

Fail
Restart HDC1000;
Try accessing it for
2 tries

HDC I2C
access
Fail

Pass

Try another
HDC1000 start
conversion

HDC1000 not
responding; Use
dummy packet
(all FF) for HDC
data

Fail

Pass

HDC I2C
access
Pass
Read HDC1000 humidity
and temperature results

Read OPT3001 light result

OPT3001 shutdown to
reduce power consumption

Send packet

Go into standby mode while
waiting for counter to
timeout

图 10. Firmware Flowchart
The flowchart shown in 图 10 consists of the CC1310 operating in continual transmission mode. It starts
with initializing the wireless MCU peripherals and I/O ports.
22

适用于低于 1GHz 网络的能量收集环境光和环境传感器节点

ZHCU182B – December 2015 – Revised May 2016

TIDUB22 — http://www-s.ti.com/sc/techlit/TIDUB22
版权 © 2015–2016, Texas Instruments Incorporated

System Design Theory

www.ti.com.cn

In the infinite loop of measurement, the CC1310 first determines the power source to determine the rate
for sensor measurement and wireless communication. If the power source is the solar cell, a shorter
interval time of 15 seconds will be used. If the power source is the coin cell, a longer interval time of 60
seconds will be used to conserve battery life. Then, the CC1310 triggers the OPT3001 and HDC1000 to
start the conversion. Because the HDC1000 has a higher operating voltage compared to the OPT3001
and CC1310, a check is added to make sure that the HDC1000 is still functioning at the lower operating
voltage. If the voltage is too low for the HDC1000 is function properly, the HDC1000 conversion is aborted
and dummy HDC data will be used.
As the OPT3001 and HDC1000 are converting, the CC1310 goes into standby mode. The CC1310 will
wake up and read the results when either the HDC1000 or OPT3001 data ready line becomes active.
After the CC1310 has acquired the temperature, humidity, and light data, a packet with the data will be
transmitted. No additional configuration is needed for the HDC1000 and OPT3001 because the devices
will automatically go into low power mode after a conversion. The CC1310 will enter standby mode again
and wait for the interval counter to timeout before the next cycle of measurement.
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5

Getting Started Hardware

5.1

Hardware Overview
图 11 shows the hardware for the Energy Harvesting Ambient Light and Environment Sensor Node for
Sub-1GHz Networks TI Design. The PCB is in a 2.0×3.0-in rectangular form factor and comes with 0.5-in
nylon standoffs to ensure ease of use while performing lab measurements.

图 11. Energy Harvesting Ambient Light and Environment Sensor Node for Sub-1GHz Networks
Reference Design Hardware
For both the solar cells to charge the capacitor reservoir, short jumper J1 with a jumper shunt. Short pins
1 and 2 of J4 with a jumper shunt to power the system from the battery when the solar energy is not high
enough to charge the capacitor reservoir or maintain continuous system operation. Also short pins 3 and 4
on J4 with a separate jumper shunt to connect the output of the bq25505 to the sensor nodes and the
CC1310.
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5.2

Loading Firmware
The firmware used on this TI Design was developed using TI’s Code Composer Studio software (version
6.1.0).
The IAR Embedded Workbench for ARM () also supports the CC13xx line of SimpleLink products.
To program or debug the TI Design hardware, no jumper shunts are required because the bq25505 does
not need to be programmed internally; it only requires external voltage dividers for voltage-level settings
for its internal power management.
Powering the board from 3.0 V is also necessary and can be supplied at pin 3 on J4.
The TI Design hardware is programmed by connecting the 10-pin mini ribbon cable from J7 to the
SmartRF06 Evaluation Board (10-pin ARM Cortex Debug Connector, P418). See 图 12 for a photo of the
correct setup for connecting the TI Designs hardware to the SmartRF06 evaluation board.

图 12. Connection of SmartRF06 Evaluation Board and TI Designs Hardware for Programming
and Debugging
There are two different programs that were used for operating this TI Design; one is for the continual
transmission ambient sensing option while the other is for the interrupt-based ambient sensing option.

5.3

Receiving Data Packets
This TI Design is designed to read light, relative humidity, and temperature data from the OPT3001 and
HDC1000, respectively. The CC1310 is then to broadcast that data as a non-connectable data packet.
The packets consist of two bytes for the TI design identifier, two bytes of relative humidity data, two bytes
of temperature data, and two bytes of light data.
To verify the proper operation of the radio transmission, two methods to view the transmitted packet are
described in the next two sections.
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Building Automation Sub-1GHz Sniffer Application
The first method is a sniffer application running on the SmartRF06 EVM with the CC13xxEM radio. The
sniffer application will process the received packet and display the calculated data on the LCD screen.
The LCD screen will show the six most current received data. If more data is needed for testing or
characterization purposes, 节 5.3.2 describes how to get more data samples for post analysis.

图 13. Sniffer Application Running on the SmartRF06 EVM With the CC13xxEM Radio
For more information about the sniffer GUI, download and install the Building Automation Sub-1GHz
Sniffer software package available in 8.8 节 of the TI Design tools page.
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5.3.2

CC1111 USB Dongle and SmartRF Protocol Packet
The second method uses the CC1111 USB Dongle. The CC1111 USB EVM Kit 868/915 MHz "sniffs"
packets using the SmartRF™ Protocol Packet Sniffer software. The data will be displayed as raw data
stream. This data stream can be post processed and used for testing and characterization. After installing
the packet sniffer software (v2.18.1 at the time of writing), the procedure is as follows to detect the data
transmissions:
1. Plug the CC1111 USB dongle into an unused USB port on the computer with the packet sniffer
software installed.
2. Open the packet sniffer software; choose Generic as the protocol and click the Start button
(see 图 14).

图 14. Packet Sniffer Start Screen
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3. Configure the CC1111 correctly to see the packets. Select the Radio Configuration tab. Under the
Register settings sub tab, click on the "Browse…" button. Open the TIDA-00488_CC1111.prs file.
Highlight and double-click on "TIDA-00488_CC1111" to apply the register settings shown in 图 15.

图 15. Radio Configuration and Monitor Screen

注:
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If long data acquisition periods are expected, increase the Cache Buffer size in the packet
sniffer software to prevent possible crashes. Take this action by opening the Settings menu
and clicking "Cache buffer size...".
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4. Press the Play button on the top toolbar to initiate the packet capture process.
5. The packet sniffer software is likely to detect many other packets. Apply a display filter to view only the
valid data packets.

图 16. Unfiltered Radio Data
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6. The appropriate filter checks for only valid packets. In the Field Name field, select "FCS" from the
dropdown options. Click the button labeled "First." Modify the filter condition to only show "OK" packets
by typing "FCS=OK" in the Filter condition field, click the "Add" button, and then click the "Apply" filter
button. The screen capture in 图 17 shows an example filtered view.

图 17. Filtered Radio Data
7. To export the captured filtered packets, click the "Save the current session" button on the toolbar
(appears as a floppy disk), or pause the packet capture and click File → Save data… from the file
context menu; either of these choices prompts to save the displayed data as a packet sniffer data
(.psd) file.
8. Use HexEdit software (http://www.hexedit.com/) to convert the .psd file to readable hex values. A
different hex editor may perform this function as well; however, the authors of this document have not
verified any other options.
9. Open the .psd file in the HexEdit software. Click on Tools → Options. In the HexEdit Options window,
click on Document → Display and change the Columns value to "2066". Click Edit → Select All and
Edit → Copy As Hex Text. Open a text editor program (for example, Notepad), paste the hex text, and
save the text file. This text file can then be imported into Microsoft® Excel® spreadsheet software for
further analysis. For more information on the sniffer data packet format, click Help → User Manual on
the packet sniffer software.
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6

Test Data
As described in 4.2 节, the TIDA-00488 firmware provides data packets continuously. The system is
powered by the solar cells U1 and U2 or by the CR2032 battery. When the light level is sufficient, the
bq25505 stores energy harvested by the solar cells on a bank of capacitors and controls whether the
system is powered by the stored energy or by the primary cell.
The continual transmission ambient sensing application for the Energy Harvesting Ambient Light and
Environment Sensor Node for Sub-1GHz Networks TI Design is intended to rely primarily on ambient light
for system power, using a CR2032 coin cell as a backup power source only. This application of the TI
Design has been characterized for optimized power management and power consumption.
The TIDA-00488 is optimized for use near a window that allows direct sunlight into a building. To simulate
the light levels experienced near a window, the day time light level was measured in a slightly dirty, south
facing window with an ultra-violet (UV) coating film installed. The dirt and UV film attenuate the solar rays
significantly. Measurements were made under several conditions. In mid-morning, before the sun was
shining directly into the window, the light level was about 1,000 lux. Mid-day light levels were closer to
5,000 lux when the sky was clear and about 3,200 lux when a cloud was passing over the sun on a partly
cloudy day. Indoor ambient light levels away from the window varied from 250 to 450 lux depending upon
the location.
The oscilloscope used in the following tests is a Tektronix MDO3024 Mixed Domain oscilloscope with a
Tektronix TCP0030A current probe for current readings. Current below 1 mA is measured with a
Keysight/Agilent 34410A 6½ Digital Multimeter (DMM).

图 18. Light Meter Measuring Light Level in a Sunny Window
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Transition Voltage
The bq25505 is programmed to power the system from the CR2032 primary cell until the capacitor
reservoir (C6 through C17) voltage reaches 2.5 V. The system is then powered from the capacitor
reservoir. 图 19 shows the power transition.

图 19. Power Transition From Primary Cell to the Capacitor Reservoir Charged by the Solar Cells
In the figures in this section, there are four oscilloscope traces:
•

The dark blue trace is the voltage of the capacitor reservoir, VBAT, measured at test point TP3

•

The purple trace is the signal VB_PRI_ON

•

The green trace is signal VB_SEC_ON

•

The light blue trace is the voltage VDD_3p3 that powers the CC1310 and the two sensors

In 图 19, VBAT is 2.5 V. The cursors show that VDD_3p3 starts at 2.84 V and drops to 2.58 V after the
transition to solar power. During the test, the battery voltage was 3.086 V when measured with a DMM.
The drop to 2.84 V is caused by reverse protection diode D2.
Signal VB_PRI_ON controls Q2. When VB_PRI_ON is low, the system is powered by the primary cell.
Signal VB_SEC_ON controls Q1. When VB_SEC_ON is low, the system is powered by the solar cell and
capacitor reservoir. In 图 19, there is a 5.12-μs period in which the power to the system is not connected
to either the primary cell or the capacitor reservoir. This is a very short duration for this system, so there is
no significant voltage drop to the system during the transition.
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When the system is being powered by the capacitor reservoir, the system power is switched to the primary
cell when the reservoir voltage drops to 1.9 V. 图 20 shows the power transition from the solar cell and
capacitor reservoir to the primary cell.

图 20. Power Transition From Primary Cell to the Capacitor Reservoir Charged by the Solar Cells
The trace colors in 图 20 represent the same signals as in 图 19. The capacitor reservoir voltage here is
1.92 V. The battery voltage minus the D2 voltage is 2.76 V. There is a 4.56-μs period in which the power
to the system is not connected to either the primary cell or the capacitor reservoir.
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Solar Cell Capacitor Reservoir Charge Time
The amount of energy provided by the solar cells varies depending upon the amount of light incident on
the cells. A higher lux level charges the capacitor reservoir faster. The results in this section use light
levels of 1,000 lux, 2,000 lux, and 4,000 lux. Light levels were measured with an Extech Instruments
model 407026 light meter. The primary light source during the tests was a Fostec Ace I adjustable light
attached to a microscope that could be raised and lowered to help adjust the light level. Some ambient
light also made up part of the incident light. The light level was measured near the center of the light spot
provided by the microscope light. The light meter sensor was then moved away and the TIDA-00488
system board under test was placed with the solar cells positioned in the same spot the light meter sensor
had been in. The test setup is shown in 图 21.

图 21. Light Measurement Setup With Microscope Light at 2880 Lux
The TIDA-00488 did not have the CR2032 battery installed during the charging tests. The voltage VBAT at
test point TP3 was measured to determine the charging rate. The voltage at TP3 is measured with an
oscilloscope to provide data over the long period of time the capacitor reservoir takes to discharge. A
DMM is also connected between TP3 and ground to give instantaneous feedback of the voltage. To begin
the test, the jumper J1 is removed to disconnect the solar cells from the bq25505 boost charger. The
capacitor reservoir is then discharged by connecting a resistor across one of the capacitors and allowing
the measured voltage on the reservoir to drop to 30 mV or less. Once the oscilloscope is ready to trigger,
jumper J1 is replaced and the capacitor reservoir is allowed to charge up.
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图 22 shows the charge time for a 1,000-lux light level. There are several points of interest during the
charging process. The capacitor reservoir is charged to 1.5 V at a very slow rate. This is the "cold start"
period defined in the bq25505 datasheet. Above 1.5 V, the boost converter in the bq25505 starts and the
charging rate increases greatly. Once the capacitor reservoir voltage reaches 2.5 V, the load is connected
to the reservoir for power. When the load is connected, there is a large voltage drop as the bypass and
filter capacitors in the main part of the system charge up. The capacitor reservoir charge rate slows down
due to the intermittent load that is applied by the system during data collection and transmission. The
CC1310 transmission cycle occurs every 15 seconds, which causes the jagged look of the oscilloscope
trace as the voltage increases further. The capacitor reservoir continues charging until the voltage limit of
3.5 V is reached. Once 3.5 V is reached, the reservoir is recharged to 3.5 V after every transmission. 图
22 shows that it takes about 435 seconds to charge to 1.5 V, 545 seconds to charge to 2.5 V, and about
700 seconds to charge to 3.5 V.

图 22. Capacitor Reservoir Charging Profile With 1,000 Lux Light Level
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Charging curves for 2,000 lux and 4,000 lux are shown in 图 23 and 图 24.

图 23. Capacitor Reservoir Charging Profile With 2,000 Lux Light Level

图 24. Capacitor Reservoir Charging Profile With 4,000 Lux Light Level
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The green trace in both 图 23 and 图 24 is the VB_SEC_ON signal described in 6.1 节. This was included
to more clearly show when the system load was connected to the capacitor reservoir. The number of
seconds per division is different in each view to help clearly show the detail of the VBAT trace as the
charging time decreases. The charge times for all three lux levels are shown in 表 2:
表 2. Time to Charge the Capacitor Reservoir for Different Lux Levels
LUX LEVEL

TIME TO BOOST CHARGER START
(s)

TIME TO CONNECT LOAD
(s)

TIME TO 3.5 V MAXIMUM
(s)

1000

435

545

700.0

2000

154

177

210.0

4000

73

83

96.6

Volts

图 25 shows the three charge times plotted together.

3.6
3.3
3
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0
0

1,000 Lux Charging Time
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4,000 Lux Charging Time
Boost Charger Start
Connect System Power

100

200
300
400
500
Elapsed Time (seconds)

600

700

图 25. Voltage versus Time for the Capacitor Reservoir for Three Light Levels
The TIDA-00488 was able to harvest enough energy for operation with light levels as low as 750 lux. It
took over 15 minutes to charge the capacitor reservoir to 2.5 V at 750 lux.
The capacitor reservoir charging curves presented here represent the worst case for the given light levels.
In normal operation, a CR2032 battery is installed in the system to provide power when light levels are
low. With the battery installed, the capacitor reservoir voltage does not drop significantly when the load is
first switched to the capacitor reservoir because the bypass and filter capacitors will already be charged.
The capacitor reservoir is unlikely to discharge to 30 mV when the system is in continuous use.
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Current Profiles
The system current was measured in two ways. For the dynamic current measurements, an oscilloscope
with a hall-effect current probe was used. This probe is not accurate for currents below 1 mA. For the very
low current standby modes, a DMM with the capability to measure current to tenths of a microamp was
used. System currents were measured with the system powered with a 3-V power supply unless otherwise
noted.

6.3.1

Standby Current
The standby current was measured using a DMM. During the system idle time, the average current was
1 μA.

6.3.2

Current During Active Time
There are three periods of activity in continuous mode operation:
•

In the first period, the CC1310 triggers the conversions in the light sensor and the temperaturehumidity sensor.

•

The second period is when the temperature-humidity sensor data is read.

•

The third period is when the light sensor data is read and when the RF transmission occurs

图 26 shows the first two active periods.

图 26. Current Profile During Conversion Trigger and Temperature-Humidity Sensor Read
The initialization and read occur about 7 ms apart. The CC1310 enters the standby state between these
times.
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The second sensor read and data transmission occurs 100 ms after the first read (see 图 27).

图 27. Current Profile of Sensor Data Conversions, Data Reads, and RF Transmission
A closer view of the light sensor data read and RF transmission current are shown in 图 28.

图 28. Light Sensor Data Read and RF Transmission
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The total time the CC1310 is awake during the second sensor read and RF transmission period is 6.65
ms. The peak current of 8.7 mA occurs during data transmission.
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图 29 shows the current during one complete 15-second transmit cycle.

图 29. System Current Showing One Complete Transmit Cycle

注:

The system was powered by a CR2032 battery during this trial.

During the 15-second cycle, there are several additional periods of current consumption. The current
transients occur when the CC1310 DC-to-DC converter activates to maintain its regulated output voltage.
These current transients are short. A typical current transient is shown in 图 30. The current transients can
be as high as 17.5 mA and the transients last about 190 μs. 图 29 shows there are about 39 of these
transients during one 15-second transmit cycle.
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图 30. Current Transient During CC1310 Shutdown
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The average current used during one cycle can be computed by finding the average current during the
individual events shown in the previous figures. First, the average current during each event is calculated
along with the total time for each event. The data for each of the graphs was saved so that accurate
current averages and pulse widths could be determined. The amount of charge for each event was
computed by multiplying the average current by the pulse width:
I AVG ´ t Event = Q Event
(7)
Where I is in amperes, t is in seconds, and Q is in coulombs. The current transient event occurs 39 times
during a 15-second cycle, so 39 times that amount of charge is required during a cycle. For the portion of
the cycle that is not part of one of these events, the CC1310 application processor is in shutdown mode.
During that time, the current consumption of the system is only 1 μA. 表 3 shows the results of the
calculations.
表 3. Average Current and Total Charge During a 15-Second Transmission Cycle
EVENT

NUMBER OF
EVENTS PER
CYCLE

TIME (s)

AVERAGE
CURRENT (mA)

AVERAGE
CHARGE (C)

TOTAL
CHARGE (C)

TOTAL TIME (s)

Sensor
initialization

1

0.001460

2.360

3.45E-06

3.45E-06

0.001460

Sensor read 1

1

0.001254

2.490

3.12E-06

3.12E-06

0.001254

Sensor read 2
and transmission

1

0.006650

5.680

3.78E-05

3.78E-05

0.006650

Current transient

39

0.000182

2.120

3.86E-07

1.51E-05

0.007098

14.987950

0.001

1.50E-05

1.50E-05

14.981040

7.44E-05

14.997500

Standby time
Grand totals

4.96E-03

The total cycle time was found to be 14.9975 seconds. Total charge is 74.4 μC. Therefore, the average
current is
Q Event
I AVG =
t Event
(8)
The average current during the cycle is 4.96 μA.

ZHCU182B – December 2015 – Revised May 2016

适用于低于 1GHz 网络的能量收集环境光和环境传感器节点

TIDUB22 — http://www-s.ti.com/sc/techlit/TIDUB22
版权 © 2015–2016, Texas Instruments Incorporated

43

Test Data

www.ti.com.cn

Using this information, estimates can be made for shorter cycles. For an eight-second cycle between
transmissions, there are still 30 current transients to maintain the CC1310 regulator voltage. For a fivesecond cycle, there are 23 current transients. Using the results in 表 3, the average current would be
approximately 7.99 μA for an eight-second cycle and 11.64 μA for a five-second cycle. See 表 4 and 表 5
for the full results.
表 4. Average Current and Total Charge During an Eight-Second Transmission Cycle
EVENT

NUMBER OF
EVENTS PER
CYCLE

TIME (s)

AVERAGE
CURRENT (mA)

AVERAGE
CHARGE (C)

TOTAL
CHARGE (C)

TOTAL TIME (s)

Sensor
initialization

1

0.00146

2.36

3.45E-06

3.45E-06

0.00146

Sensor read 1

1

0.001254

2.49

3.12E-06

3.12E-06

0.001254

Sensor read 2
and transmission

1

0.00665

5.68

3.78E-05

3.78E-05

0.00665

Current transient

30

0.000182

2.12

3.86E-07

1.16E-05

0.00546

7.985176

0.001

7.99E-06

7.99E-06

7.985176

6.39E-05

8

Standby time
Grand totals

7.99E-03

表 5. Average Current and Total Charge During a Five-Second Transmission Cycle
EVENT

NUMBER OF
EVENTS PER
CYCLE

TIME (s)

AVERAGE
CURRENT (mA)

AVERAGE
CHARGE (C)

TOTAL
CHARGE (C)

TOTAL TIME (s)

Sensor
initialization

1

0.001460

2.360

3.45E-06

3.45E-06

0.001460

Sensor read 1

1

0.001254

2.490

3.12E-06

3.12E-06

0.001254

Sensor read 2
and transmission

1

0.006650

5.680

3.78E-05

3.78E-05

0.006650

Current transient

23

0.000182

2.120

3.86E-07

8.87E-06

0.004186

4.986450

0.001

4.99E-06

4.99E-06

4.986450

5.82E-05

5

Standby time
Grand totals

1.16E-02

In these three examples, the amount of charge used will be slightly higher. This is because the CC1310
application processor enters standby state during the period between sensor initialization and sensor read
1. The processor also enters standby during the period between sensor read 1 and sensor read 2 plus
transmission.
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6.4

Capacitor Reservoir Sizing
The capacitor reservoir has a nominal capacitance of 1200 μF. 6.2 节 shows that the charging rate of the
capacitor reservoir for different light intensities. Lower light intensity results in a lower amount of charge
generated by the solar cell. During the charging period, the amount of charge into the capacitor reservoir
can be estimated using 公式 9:
DV ´ F = DQ Re servoir
(9)
ΔV is the change in voltage on the capacitor reservoir, F is the reservoir capacitance, and ΔQ is the
change in charge on the capacitor reservoir given the change in voltage. 图 31 shows a portion of the
voltage rise during the charging of the capacitor reservoir when the light intensity is 1,000 lux.
2.95
2.9

Volts

2.85
2.8
2.75
2.7
2.65
440

442

444

446

448 450
Seconds

452

454

456

图 31. Voltage Rise Between Transmissions During Capacitor Reservoir Charging With 1000 Lux
The portion of the charging curve shown in 图 30 is only the portion that occurs between the times when
the CC1310 is in shutdown mode. The capacitor reservoir can charge during this time. In this graph, ΔV =
0.237 V, so ΔQ = 0.237 V × 1,200 μF = 284 μC. 节 6.3.2 shows that the system uses 74.4 μC during the
15-second transmission cycle. The difference between the amount of charge used be the system and the
amount of charge added to the capacitor reservoir is 284 μC – 74.4 μC = 209.6 μC, so the reservoir can
continue charging.
The time period in 图 31 is 14.86 seconds. This is the time between the end of one RF transmission and
the sensor initialization period. Once the system starts consuming energy from the capacitor reservoir, the
voltage will drop. Since this time period is for a 15-second transmission interval, performance for shorter
transmission intervals can be estimated by using the difference between the cycle times to adjust the
charge time. Therefore, an eight-second RF transmission cycle would have a charge time of 7.86
seconds. The final voltage would then be about 2.82 V and the total accumulated charge would be 153
μC. The system could still run on the solar cell with an eight-second cycle, but the charging rate would be
very slow after the system is connected to the reservoir. A five-second delay between transmissions would
not provide enough time between transmissions to recharge the reservoir to the voltage it started from.
The capacitor reservoir would deplete to 1.9 V quickly causing the system to run from the battery most of
the time.
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Notes About the Design
This design is useful where the solar cells are near a window and the average light level will be above
1,000 lux during a significant part of the system operating time. If energy harvesting operation is desired at
lower light levels, more solar cells of the same type can be added. U1 and U2 are connected in series. To
add more of the same type of solar cell, series pairs of cells could be added in parallel to the existing pair.
The overvoltage and undervoltage levels for the bq25505 would not need to be changed in the design.
Adding additional solar cell pairs in parallel increases the current available at lower light levels. A different
type of solar panel could also be used in place of the existing panels at U1 and U2. In that case, the
designer would need to adjust the bq25505 operating parameters to match the new solar cell.
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8

Design Files

8.1

Schematics
To download the schematics, see the design files at TIDA-00488.
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图 32. Energy Harvesting Schematic
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LPRF Bypass Capacitors & DC-DC Passives
Ambient Light Sensor

Pin 33
L3

VDDS
Pin 13

L2
TP6

TP7

TP8

BLM18HE152SN1D
1500 ohm

U4
1

VDD_3P3

C20
0.1µF

2

3

GND
GND

VDD
ADDR

SCL
SDA
INT

GND

PAD

4
6
5

Pin 22

Pin 44

Pin 34

I2C_SCL
I2C_SDA
INTERRUPT

DNPC21

C22
0.1µF

GND

GND

C23
0.1µF

GND

C24
0.1µF

C25
22µF

GND

GND

VDDR
Pin 33

DCDC_SW

VDD_3P3

6.8µH

C26
0.1µF

Pin 45

C27
22µF

GND

GND

Pin 48

C28
0.1µF

C29
DNPC30
0.1µF
0.1µF

GND

GND

GND

7

OPT3001DNP

GND

I2C Address = 100 0100 (x44)

Wireless MCU
Humidity to Digital Converter

VDDS

U7
J5

VDD_3P3

C43
0.1µF

I2C_SCL
I2C_SDA
nDRDY_HDC

GND

B1

VDD

A1
A2
D2

SCL
SDA
DRDY

C1
D1

TP9

ADR0
ADR1

I2C_SCL
I2C_SDA
INTERRUPT
nDRDY_HDC

B2

GND

I2C Address = 100 0000 (x40)

USR_BTN
VBAT_OK

GND

VB_PRI_ON
VB_SEC_ON

R3
DNP
0
R11
DNP
0

User and Reset Switches
VDDS

VDDS

R12
47.5k

nRESET
JTAG_TCK
JTAG_TMS

R13
47.5k

DIO_1
DIO_2
DIO_3
DIO_4
DIO_5
DIO_6
DIO_7
DIO_8
DIO_9
DIO_10
DIO_11
DIO_12
DIO_13
DIO_14
DIO_15

35

RESET

25
24

JTAG_TCKC
JTAG_TMSC
DCOUPL

DIO_16
DIO_17
DIO_18
DIO_19
DIO_20
DIO_21
DIO_22
DIO_23
DIO_24
DIO_25
DIO_26
DIO_27
DIO_28
DIO_29
DIO_30
DCDC_SW

RX_TX
RF_P
RF_N

1
2
3
4DNP
5
6

26
27
28
29
30
31
32
36
37
38
39
40
41
42
43
33

TSW-106-07-G-S

C34
0.6pF
C33
3.6pF

L5
18nH

RX_TX

L6
6.8nH

7.5nH

47
46

X24M_P
X24M_N

X32K_Q2
X32K_Q1

5
4

X32K_Q2
X32K_Q1

L8
7.5nH

49

R18
0

L7
6.8nH
C40

C37
2.7pF

C36

X24M_P
X24M_N

EP

L4

DCDC_SW
GND

3
1
2

E1
ANTENNA_HELICAL

GND

C38
6.2pF

C39
100pF
3.3pF

R19
DNP
0

L9
11nH

GND
J6
CONSMA001-SMD-G
1

DNP

3.6pF
GND

GND

GND

GND

RX_TX

1
2

1

U5
TPD1E10B06DPYR

C32
2200pF

C41
1µF

C42
100pF

CC1310F128RGZR
GND

C44
GND

GND

DNP

1

2

2

1

2

S2
B3U-1000P

U6
TPD1E10B06DPYR

2

1

2

C31
2200pF

VDDR
VDDR

6
7
8
9
10
11
12
14
15
16
17
18
19
20
21

23

nRESET

1

USR_BTN

S1
B3U-1000P

45
48

VDDR
R14
R15
R16
R17
10.0k 10.0k 4.75k 4.75k

C2

DNC

HDC1000YPAR
GND

VDDS
VDDS2
VDDS3
VDDS_DCDC

1

VDDS VDDS VDDS VDDS

44
13
22
34

5
4
3
2

U10

Y1
1
3

GND

GND

G
G

2
4

TSX-3225 24.0000MF20G-AC3
24 MHz
C45

JTA G Programming Interface

DNP

U8
J7
1
3
5
7
9

2
4
6
8
10

JTAG_TMS
JTAG_TCK
1
nRESET

1

2

GND

2

C46

TPD1E10B06DPYR
U9
1

12pF

2

1

2

2

TPD1E10B06DPYR

1

VDDS

GRPB052VWVN-RC

Y2
FC-12M 32.7680KA-A3
32.768KHZ
C47

GND
GND
12pF
GND

图 33. Bluetooth® and Light Sensing Schematic
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8.2

Bill of Materials
To download the bill of materials (BOM), see the design files at TIDA-00488.

8.3

Layer Plots
To download the layer plots, see the design files at TIDA-00488.

8.4

Altium Project
To download the Altium project files, see the design files at TIDA-00488.

8.5

PCB Layout Recommendations
To ensure high performance, the Energy Harvesting Ambient Light and Environment Sensor Node for
Sub-1GHz Networks TI Design was laid out using a four-layer PCB. The second layer is a solid GND
pour, and the third layer is used for power rail routing with GND fills in unused areas. The top and bottom
layers are used for general signal routing and also have GND fills in unused areas.
For all of the TI products used in this TI Design, adhere to the layout guidelines detailed in the respective
datasheets.

8.6

Gerber Files
To download the Gerber files, see the design files at TIDA-00488.

8.7

Assembly Drawings
To download the assembly drawings, see the design files at TIDA-00488.

8.8

Software Files
To download the software files, see the design files at TIDA-00488.
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IMPORTANT NOTICE
有关 TI 设计信息和资源的重要通知
德州仪器 (TI) 公司提供的技术、应用或其他设计建议、服务或信息，包括但不限于与评估模块有关的参考设计和材料（总称“TI 资源”），旨在
帮助设计人员开发整合了 TI 产品的 应用； 如果您（个人，或如果是代表贵公司，则为贵公司）以任何方式下载、访问或使用了任何特定的
TI 资源，即表示贵方同意仅为该等目标，按照本通知的条款进行使用。
TI 所提供的 TI 资源，并未扩大或以其他方式修改 TI 对 TI 产品的公开适用的质保及质保免责声明；也未导致 TI 承担任何额外的义务或责任。
TI 有权对其 TI 资源进行纠正、增强、改进和其他修改。
您理解并同意，在设计应用时应自行实施独立的分析、评价和 判断， 且应全权负责并确保 应用的安全性， 以及您的 应用 （包括应用中使用
的所有 TI 产品））应符合所有适用的法律法规及其他相关要求。你就您的 应用声明，您具备制订和实施下列保障措施所需的一切必要专业知
识，能够 (1) 预见故障的危险后果，(2) 监视故障及其后果，以及 (3) 降低可能导致危险的故障几率并采取适当措施。您同意，在使用或分发包
含 TI 产品的任何 应用前， 您将彻底测试该等 应用 和该等应用所用 TI 产品的 功能。除特定 TI 资源的公开文档中明确列出的测试外，TI 未进
行任何其他测试。
您只有在为开发包含该等 TI 资源所列 TI 产品的 应用时， 才被授权使用、复制和修改任何相关单项 TI 资源。但并未依据禁止反言原则或其他
法理授予您任何TI知识产权的任何其他明示或默示的许可，也未授予您 TI 或第三方的任何技术或知识产权的许可，该等产权包括但不限于任
何专利权、版权、屏蔽作品权或与使用TI产品或服务的任何整合、机器制作、流程相关的其他知识产权。涉及或参考了第三方产品或服务的信
息不构成使用此类产品或服务的许可或与其相关的保证或认可。使用 TI 资源可能需要您向第三方获得对该等第三方专利或其他知识产权的许
可。
TI 资源系“按原样”提供。TI 兹免除对 TI 资源及其使用作出所有其他明确或默认的保证或陈述，包括但不限于对准确性或完整性、产权保证、
无屡发故障保证，以及适销性、适合特定用途和不侵犯任何第三方知识产权的任何默认保证。
TI 不负责任何申索，包括但不限于因组合产品所致或与之有关的申索，也不为您辩护或赔偿，即使该等产品组合已列于 TI 资源或其他地方。
对因 TI 资源或其使用引起或与之有关的任何实际的、直接的、特殊的、附带的、间接的、惩罚性的、偶发的、从属或惩戒性损害赔偿，不管
TI 是否获悉可能会产生上述损害赔偿，TI 概不负责。
您同意向 TI 及其代表全额赔偿因您不遵守本通知条款和条件而引起的任何损害、费用、损失和/或责任。
本通知适用于 TI 资源。另有其他条款适用于某些类型的材料、TI 产品和服务的使用和采购。这些条款包括但不限于适用于 TI 的半导体产品
(http://www.ti.com/sc/docs/stdterms.htm)、评估模块和样品 (http://www.ti.com/sc/docs/sampterms.htm) 的标准条款。
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